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of accounting software packages and productivity tools. Along with his background in public
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He welcomes your comments and suggestions.
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TUTORIAL OBJECTIVES:

It is not my intention for this tutorial to cover all of the options and financial tools that Quicken has
to offer. The purpose of this tutorial is to help you learn and be very comfortable and confident
with Quicken, so you will be inspired to use Quicken to manage your finances on a regular basis.

In the first three lessons we will be using sample data. The final lesson is a workshop where you will
be using your own personal data.

After completing this tutorial, you will be able to:

� Set up a personal data file

� Create accounts (bank accounts, credit card accounts, etc.)

� Create categories of income and expenditures

� Enter and memorize transactions

� Backup your data files

� Transfer funds between accounts

� Memorize and schedule recurring transactions using the Financial Calendar

� Create and memorize financial reports
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INTRODUCTION

As you are likely aware, Quicken® for Windows® is personal financial software designed to work
like you think; it uses screens and terminology which are familiar to you.

This tutorial is based upon Quicken Version 5 for Windows. Some of you may have an earlier
version and may or may not wish to upgrade, depending on whether you need the additional
financial tools that have been added in the later versions. Also, there may be slight variations in
windows and keystrokes as compared to earlier versions.

It is very important that youfollow the tutorial exactly . Otherwise, it may be difficult for you
to return to where you left the tutorial.Read each numbered paragraph in its entirety before
you perform an action.

For consistency, this tutorial will usually instruct you to click the mouse to select menu items,
icons and buttons. However, you may prefer to use the keyboard for some operations.

Caution: Many of you will want to press the Enter key after typing information into a field. At
times this will cause you to enter a transaction or leave a window prematurely. The reason for
this is that pressing the Enter key selects whichever item or button is highlighted. The problem
occurs when the OK button or the Return button is highlighted. We will be selecting an option
that will solve this problem when entering transactions. However, in all other cases, be sure you
press the Tab key or use the mouse to move to the next field. Only press Enter as an alternative
to clicking the mouse on an item or button that is already highlighted.

Feel free to select the various Help buttons at any timeas you go through the tutorial. Close
the Help windows when finished reading and continue with the tutorial. You close a Help
window by clicking its control box (the minus sign in the upper left corner) and then selecting
Close.

OBJECTIVES OF LESSON 1:

· Learn Quicken terminology

· Install the software (if not already installed)

· Set up a sample data file

· Set up a bank account

· Add a new expense category

· Enter a transaction

· Backup your data file
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TERMINOLOGY

Account A Quicken account is familiar to all of us - it is a bank account, a savings account, a
credit card account, and so forth.

An account is the source of all our transactions. It is where we deposit our pay checks and
pension income; it is where we write our checks or charge expenditures using credit cards.
Money is also transferred from one "account" to another. For example, we write a check from
our checking account to our savings account; we write a check to pay down our credit card
account.

File A Quicken data file contains all your accounts and transactions.

Transaction A Quicken transaction is any deposit, check or payment to a Quicken "account".

Category A Quicken category is a category of income or a category of expenditures. Pension
Income, Interest and Dividend Income are categories of income. Food, utilities and computer
supplies are categories of expenditures. Every transaction in a Quicken "account" will have a
corresponding category that you want to track.

Register A Quicken register contains all of the transactions related to a particular "account".
There are checking account registers, savings account registers, credit card registers, and so forth.
For example, a checking account register looks like your checkbook; a savings account register
looks like your savings passbook; a credit card register looks like your credit card statement.

Menu The Quicken menu bar is located just below the Quicken for Windows title bar. Selections
can be made from the various drop-down menus.

Icon The Quicken iconbar is locate just below the menu bar. These icons are short-cuts to many
of the drop-down menu selections. You can determine which icons you want to appear on the
iconbar.

Tab Quicken tabs appear in the Account List, the Category & Transfer List, and in some of the
options windows. They look and act like file folder tabs. Certain selections or options are
displayed under a particular tab.

Button Quicken buttons are located within a Quicken window and perform a particular operation.
They may appear across the top of a register or list, or they may appear at other locations in the
window.

Field A field is a space for a particular item of information.

Click Click means to quickly press and release the leftmouse button.

Double-click Double-click means to click the mouse button twice in rapid succession.
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INSTALLATION

Intuit designed Quicken to be "intuitive" from the very beginning.
During installation you are prompted every step of the way, with
help windows to answer your questions.

1) If you have already installed Quicken on your own
computer, skip to page 5.

2) If you are now installing this version of Quicken, follow
the installation instructions on beginning on page 2 of your
Getting Started manual.

Respond to the Quicken prompts and read the on-screen
introductory messages during the installation process.

3) Remove your final Install Disk andSelect the Quicken for
Windows icon to begin using Quicken.

4) If you have just installed this version of Quicken for
Windows, the New User Setup window will appear on your
screen.

5) Click Next to go through Quicken's New User Setup. Let
Quicken help you set up your first checking account.

6) Select QuickTour at the "What's next?" window. It will
take some time to go through all of the QuickTour topics.
I suggest you select "Organizing Your Finances" and the
"Quicken Overview" at this time. Whenever you want to
review the QuickTours, the Quicken Tips or the Windows
Tutorial, you can access them from the Help menu.

7) Upon completion of New User Setup, Quicken opens the
checking account you have just set up. (If not, perhaps you
canceled the setup at some point, which is not a problem.)

If Quicken did open the checking account register, note the
Quicken for Windows title bar. Quicken has named this file
"QDATA". You can use this file for practice. For the
purpose of this tutorial, we will be setting up our own
accounts under a sample data file.
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SET UP A NEW FILE

Quicken allows you to set up multiple data files. You will typically
use one data file for your household. You might also set up
separate data files for other family members, friends or clients. For
the purpose of this tutorial, we will set up a sample data file.

1) Click the File menu, which is located on the menu bar just
below the Quicken for Windows title bar.

2) Click New.
(If Quicken opens an "Are you sure?" window, click OK.)

3) Type tutor5 as the File Name. (DO NOT press Enter.)

4) Note the "Predefined categories" at the lower right corner
of the window. We want to select only the Home
categories. If "Home" is not checked, click its box.

5) Click OK.

6) If Quicken asks if you would like to see a summary of new
features at this time, click NO. You can view it at another
time by clicking the Help icon, Searching for "Quicken"
and Clicking the topic "What's New in Quicken 5 for
Windows".
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NOTES
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SET UP YOUR FIRST NEW ACCOUNT

When you set up a new file, Quicken automatically opens the
Create New Account window.

1) Click Checking to set up a checking account.

2) Click Next to let EasyStep help us set up our first account.

3) Type 1st Bank-Chkgas the Account Name andPress Tab
to move to the next field.

4) Type A/C 01-2345-6as the Optional Description andClick
Next. (Or you may want to use the optional description to
expand the account name.)

5) Since we do have our last statement, accept the "Yes"
answer andClick Next.

6) Type the 1st of the prior month as the Statement Date
andPress Tab.(For example, "12/01/95" if January is our
current month)

7) Type 100.00as the Ending Balance andClick Next.

8) We have not signed up to use an online service. Accept the
"No" answers andClick Next.

9) We would like to enter additional information -Click Yes
and then Click Next.

10) Type any information in the various fields and Click
Next when finished.

11) It will be more efficient to set up our next checking account
if we bypass EasyStep.

To bypass this feature when setting up the next checking
account,Click the "Start with Summary" box , which is
located in the lower left corner of the window, and then
Click Next.



A Quicken® for Windows® Tutorial
Copyright © 1995 - 1996 Donald Bayne, CPA, All Rights Reserved LESSON 1

NOTES

7

SET UP YOUR FIRST NEW ACCOUNT, Continued

12) Click Done to complete the setup.

13) Quicken opens the register window for the checking
account you have just set up. It looks very much like your
own check book register. Note your opening balance entry
of $100.00.

14) Click the Lists menu.

15) Note Ctrl+A to the right of Account. It is the Quick Key
(shortcut) to open the Account List.

16) Click "Account" to open the Account List.

17) Click the Info button , which is located below the Account
List title bar.

This is where you can also enter additional information that
may have not been available when you set up the account.

18) Click OK.

19) Click the Edit button , which also is located below the
Account List title bar.

This is where you can change account names and
descriptions, additional information and tax information.

20) Click Cancel. (Or you can press the Esc key, which is
usually located at the upper left corner of your keyboard.)

21) Click the Delete button, which also is located below the
Account List title bar.

This is where you can delete an account. However, be
advised thatALL of your transactions originating in this
account are also deleted, which is almost never a good
idea. It is better to enter a transaction to adjust the account
to zero, and wait until year-end to delete the account
AFTER all reports are printed and reconciled.



A Quicken® for Windows® Tutorial
Copyright © 1995 - 1996 Donald Bayne, CPA, All Rights Reserved LESSON 1

NOTES

8

SET UP YOUR FIRST NEW ACCOUNT, Continued

22) Click Cancel (or Press Esc).

23) Quicken confirms "Account not deleted" -Click OK .

24) Note the tabs "All Types", "Bank", "Credit", "Other" and
"Invest". Only the accounts matching the type selected will
be listed in the window. This is especially helpful if you
have a large number of accounts.

25) Click the Credit tab (for credit cards).

26) Note that the "1st Bank-Chkg" account no longer appears
in the window.

27) Click the Bank tab and it reappears.

28) Click the Close button (which also is located below the
Account List title bar) to close the Account List.
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CHECK YOUR OPTIONS

It is important that certain options be set consistent with this
tutorial. Otherwise some of your windows and keystrokes may not
match the tutorial explanation. At this point we want to set the
following options.

1) Click the Edit menu.

2) Click Options at the bottom of the Edit menu.

3) Click General.

4) "Show HomeBase on Top at Startup"should not be
checked.Click its box to remove the selection.

5) "Use Tax Schedules with Categories"should be checked.
If it is not checked, click its box.

6) "Show Flyover Help in Toolbars" is helpful. With this
option checked you can see a short description of what each
icon in Quicken does by moving the mouse pointer over the
icon for a few seconds.

7) "Remove Memorized Transactions Not Used in Last"
should not be checked. If it is checked, click its box to
remove the selection.

8) "Turn QuickTabs Off" and "Quicken Standard"should be
selected. If not selected, click their buttons.

9) The other selections are optional according to your
preference and can be explored at another time.

10) Click OK .

11) Click Register.
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CHECK YOUR OPTIONS, Continued

12) Note the three tabs across the top of the Register Options
window. Under the Display tab, the following selections
should bechecked. If not checked, click their boxes.

Show Account Selector
Show Description Bar
Date in First Column
Transaction Toolbar

"Memo before Category"should not be checked. If it is
checked, click its box to remove the selection.

"Color Shading", "Fonts" and "Colors" are optional.

13) Click the Miscellaneous tab.

14) All selectionsshould bechecked. If not checked, click their
boxes.

With regard to "Enter Key Moves Between Fields" - When
this option is selected, you can use the Enter key as well as
the Tab key to move between fields in any account register
and when writing checks.

15) Click the QuickFill tab.

16) All selectionsshould bechecked. If not checked, click their
boxes.

17) Click OK.

18) Click Iconbar.

19) "Show Icons" and "Show Text"should bechecked. If not
checked, click their boxes.

20) Click Done.

21) Close the Options window.
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CHECK YOUR OPTIONS, Continued

22) Click the Help menu. (DO NOT click the Help icon.)

23) "Show Qcards"should be checked. If it is not checked,
click on it.

24) Some of the HomeBase selections are similar to iconbar
selections. In order to clear our desktop and simplify our
selections, we will now close the HomeBase window.

Click the HomeBase control box(the minus sign to the
left of the HomeBase title bar), thenClick Close.
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ADD A NEW CATEGORY

Let us add a category that we will use for our first transaction.

1) Click the Lists menu.

2) Note Ctrl+C to the right of Category & Transfer. It is the
Quick Key (shortcut) to open the Category & Transfer List.

3) Click "Category & Transfer".

4) Quicken opens the Category & Transfer List. Use the
keypad or click the mouse on the vertical scroll bar to
Scroll through the categories.

5) "Accounts" are listed at the end of the category list.
Press End or use the mouse to go to the end of the list.

6) Note our [1st Bank-Chkg] account entry, which is the last
entry on the list. Quicken uses square brackets to
distinguish between an Account and a Category.

7) Click New.

8) Type Vacationsas the category Name andPress Tab.

9) Description is optional and is usually used to lengthen or
add more description to the category -Press Tab to skip.

10) If Expense is not already selected as the Type, click its
button.

11) Since vacations are not tax-deductible, we will not select
Tax-related or the related Form field.

12) Click OK to set up the new category.

13) Quicken returns you to the Category & Transfer List. Note
the new "Vacations" category.

14) Close the Category & Transfer List.
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ENTER A TRANSACTION

Since the "Enter Key Moves Between Fields" option is selected,
you can use the Enter key as well as the Tab key to move between
fields in any account register. You will find that the Enter key is
more efficient in some cases, while the Tab key is more efficient
in others.

1) The "1st Bank-Chkg" account register should still be open.

2) Read the Qcards as you enter this transaction, but follow
theseinstructions.

3) Enter the 5th of the prior month as the Date. (Be careful
as you enter dates. Depending on the position of your
pointer, Quicken will sometimes append rather than replace
a date.)

4) Enter 101 as the Check Number.

5) Enter Vacation Airlines as the Payee.

6) Enter 527.00as the amount in the Payment field.

7) Do not follow the instructions of the next Qcard.

Type V in the Category field and note that Quicken finds
and selects "Vacations" from the drop-down Category list.

8) Press Tabto enter the category. (DO NOT press Enter or
Quicken will skip the Memo field.)

9) Enter Boston trip in the Memo field.

10) Click Record or Press Enter(since Record is highlighted).

Beeps will sound to confirm the transaction has been
recorded.

Note the resulting register entry. Our checking account is
overdrawn. We will need to record a deposit in Lesson 2.
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BACKUP YOUR DATA FILE

Your hard disk and computer system can fail when you least
expect it. Corruption of data can occur at any time due to
fluctuations in power. A good line conditioner is one of the most
important accessories you can buy to protect your data. I
recommend a line conditioner that protects against drops in power
(brownouts) as well as surges, especially if you are near an
industrial area. An inexpensive line voltage monitor will indicate
whether you have a current power problem. But even if you have
consistent power now, it is still better to have the protection.

Backup without fail after every session. If you use Quicken to
backup onto diskettes, I suggest you use a set of diskettes, one for
each day of the week. If you use a tape backup, I suggest you do
a full backup at the end of each week, or at least monthly, and do
incremental backups in the interim. This way you can retrieve a
prior backup if you most recent backup is also corrupted.

We will use Quicken's backup feature for the purpose of this
tutorial.

1) Click the File menu.

If you select Exit and have not recently backed up your
data file, the Automatic Backup window appears and
prompts you to backup your data. Have formatted diskettes
available to use for backup at the appropriate time.

2) If you do have a backup disk available, Click "Backup".

"Current File" is selected. Note the Backup Drive indicated.
Change it if not correct.

Make sure your disk is inserted andClick OK to begin the
backup.

Quicken advises you of successful backup.

Click OK .

Now Click "Exit" from the File menu.

3) If you do not have a backup disk availableat this time,
Click "Exit" from the File menu.
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CONCLUSION

In this lesson we have learned Quicken terminology, how to set up
a bank account, add a new category, enter a transaction and backup
our data file.

In our second lesson we will set up additional "Accounts" and
"Categories", and begin entering more transactions.
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OBJECTIVES OF LESSON 2:

· Enter more checking account transactions, including a split transaction

· Edit a category and add a subcategory

· Add a savings account and enter a transaction

· Add a credit card account and enter a transaction

· Transfer funds between checking, savings and credit card accounts
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QUICKEN REMINDERS

1) Reopen Quicken for Windows.

2) If you have just installed this version of Quicken, the
Quicken Reminders window is automatically opened and
you will see a reminder to send in your registration card.

3) If the reminder window is not open, click the Activities
menu, then click Reminders.

4) We have not yet entered any notes. We will explore and
enter Calendar Notes later in the tutorial.

5) Click the drop-down button to the right of "Show notes
for" and Scroll the choices of time periods.

6) Click "Next 7 Days" (which will allow us to view a note
that we will enter in lesson 3).

7) Click the Options button, which is located below the
Quicken Reminders title bar.

8) "Turn on Billminder" and "Days in Advance" will have no
effect in this tutorial since we will not be exploring
Billminder.

9) "Show Reminders on Startup" and "Show Calendar Notes"
should be checked. If they are not checked, click their
boxes.

10) Click OK .

11) Close the Quicken Reminders window.
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ENTER A TRANSACTION AND EDIT A CATEGORY

Quicken automatically opens the last file in use. If you last worked
in this tutorial, "TUTOR5" should appear on the Quicken for
Windows title bar. If not, you need to open "tutor5.qdt" from the
File List.

1) The "1st Bank-Chkg" account register should still be open.
Quicken automatically opens the last register in use.

2) If a Qcard appears while entering this transaction,Close the
Qcard by clicking its control box (the "x" in the upper left
corner of the Qcard). ThenClick OK to confirm.

3) Let us record a deposit to cover our $427.00 overdraft.

4) Enter the 1st of the prior month as the Date.

5) Click "Deposit" from the drop-down list in the Num
(number) field andPress Tab.

6) Note the drop-down Payee list showing our last transaction.
Quicken is memorizing each new transaction for future
recall. We will explore this feature later in the tutorial.

7) Enter State of California as the Payee.

8) Note that Quicken positioned the insertion point in the
Deposit field based on your selection of DEP in the
Number field.

9) Enter 800as the amount in the Deposit field. (Quicken will
add the decimal and zero cents.)

10) Note the income categories in the drop-down Category list.
Let us use this opportunity to change an account name and
description.

Press Ctrl+C, the Quick Key to open the Category &
Transfer List.
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ENTER A TRANSACTION AND EDIT A CATEGORY, Continued

11) Note the tabs "All Types", "Income", "Expense" and
"Transfers". Only the categories matching the type selected
will be listed in the window.

12) Click the Expense tab.

13) Note that the income categories are no longer listed.

14) Click the Income tab to list the income categories.

15) Use the arrow key or your mouse toHighlight "Online
Data, Inc." and Click the Edit button , which is located
below the Category & Transfer List title bar.

16) Change the Name to PensionandPress Tab.

17) Change the Description to Pension Incomeand Press
Tab.

18) "Income" was already selected as the Type.

19) Click "Tax-related".

20) Click the drop-down button to the right of the Form field
to access the drop-down list of tax forms.

21) Scroll down near the end of the list andClick "1099R:
Total pension gross distrib".

22) Click OK .

23) Now Double-click "Pension" from the Category &
Transfer List andPress Tab.

24) Type any memo or leave it blank.

25) Record the transaction.
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ENTER A TRANSACTION AND ADD A SUBCATEGORY

1) Press +until you increment the date to the 6th of the prior
month andPress Tab.

2) Press +to increment the check number andPress Tab.

3) Enter DMV as the Payee.

4) Enter 127 as the Payment.

5) Subcategories of a parent category are indicated by the use
of a colon. (For example, "Utilities:Water")

At the Category fieldClick "Auto" from the drop-down
Category list.DO NOT press Enter or Tab. (If the list does
not drop down automatically, click the drop-down button to
the right of the Category field.)

6) Type :Licenses so that the Category field shows
"Auto:Licenses".

7) Now Press Tabto enter the category.

8) Since licenses is not a predefined subcategory of auto
expenses, Quicken opens the Set Up Category window, and
selects "Licenses" as the Name.

9) Press Tabto accept the name.

10) Type Auto Licensesas the Description andPress Tab.

11) Note that "Subcategory of Auto" is selected as the Type.

12) Click the Tax-related box.

13) Click the drop-down button to the right of the Form field.

14) Scroll down the list and Click "Schedule A:Other
Taxes".
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ENTER A TRANSACTION AND ADD A SUBCATEGORY, Continued

15) Click OK to set up and select the subcategory.

16) Enter Buick in the Memo field.

17) Record the transaction.
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ENTER A SPLIT TRANSACTION

We will now enter a check to the market where we also get cash
back.

1) Press Tabto accept the date of the 6th of the prior month.

2) Press +to increment the check number andPress Tab.

3) Enter Super Market as the Payee and45.25 as the
Payment.

4) Click Splits or Press Alt-S to access the Splits window.

5) Click "Groceries" from the down-down Category list as
the first Category. (If the list doesn't drop down
automatically, click the drop-down button to the right of the
Category field.)

6) Tab past the Memo field.

7) Enter 25.25as the Amount.

8) Enter Misc as the second Category.

9) Enter Cash back at market in the Memo field.

10) Note that Quicken fills in 20.00, which balances the split
amounts to the 45.25 total check amount.

11) Click OK or Press Alt-O to enter the splits.
(The OK button may be hidden by the drop-down Category
list).

12) Note that "-Splits-" appears in the Category field.

13) Click Record or Press Ctrl+Enter, the Quick Key to
record a transaction.
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ADD SAVINGS ACCOUNT AND ENTER A TRANSACTION

1) Click Accts from the iconbar to open the Account List.

2) Click New.

3) Click Savings.

4) Click the Summary tab to bypass EasyStep.

5) Enter Federal Savings as the Account Name;
A/C 02-3456-7as the Optional Description;1000 as the
Balance; andthe 1st of the prior month as the Date.

6) Click Next.

7) Click Info to enter any additional account information and
Click OK when finished.

8) Click the "Start with Summary" box.

9) Click Done to compete the setup.

10) Let us record last month's interest on our savings account.

Click the "Federal Savings" account.

11) Click Open.

12) Enter the last of the prior month as the Date. (For
example, "12/31/95" if January is our current month)

13) Click "Deposit" from the drop-down Number list and
Press Tab.

14) Enter Federal Savings Bankas the Payee, and4.16as the
Deposit.
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ADD SAVINGS ACCOUNT AND ENTER A TRANSACTION, Continued

15) At the Category field,Slowly type Int Inc. Quicken finds
and selects "Int Inc" from the drop-down Category list.

16) Press Tabto enter the category.

17) Enter Monthly interest in the Memo field.

18) Record the transaction.
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TRANSFER FUNDS FROM CHECKING TO SAVINGS ACCOUNT

Since the "Show Account Selector" register option is enabled, the
two accounts we have set up appear as buttons below the last
register transaction line.

1) Click the "1st Bank-Chkg" button to reopen the checking
account register.

2) Enter the 10th of the prior month as the Date.

3) Click the Transfer button , which is located below the "1st
Bank-Chkg" title bar.

4) Quicken opens the Transfer Money Between Accounts
window.

5) Accept the "Date" and "Description" entries that Quicken
has already completed.

6) Enter 100 as the Amount.

7) Note that Quicken has selected "1st Bank-Chkg" as the
Transfer Money From account.

8) Click the drop-down button to the right of the "To" field.

9) Click "Federal Savings".

10) Click OK to record the transfer of funds.

11) Use the up-arrow key to highlight this last entry.

12) Note the square brackets around [Federal Savings], the
account to which funds were transferred. Recall that
Quicken uses square brackets to distinguish between an
Account and a Category. Note TXFR is the description in
the Number field. This assumes we are transferring funds
other than by check. If we are transferring funds by check,
we would replace TXFR with a check number.
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TRANSFER FUNDS FROM CHECKING TO SAVINGS ACCOUNT, Continued

13) Click the Edit menu. (DO NOT click the Edit button.)

14) Note that Ctrl+X is the Quick Key to "Go to Transfer".

15) Click "Go to Transfer" near the bottom of the Edit menu.

16) Quicken opens the Federal Savings account and finds the
other side of the transfer. Note the deposit amount and [1st
Bank-Chkg] in the Category field, the account from which
funds were transferred.

17) Click the "1st Bank-Chkg" button to return to the
checking account register.
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ADD CREDIT CARD ACCOUNT AND ENTER A TRANSACTION

1) Click "Create New Account" from the Activities menu.
(This is another way to create a new account.)

2) Click Credit Card.

3) Click Summary to bypass EasyStep.

4) Enter 1st Credit Card as the Account Name;
A/C 1234 5678 as the Optional Description;65 as the
Balance; andthe 1st of the prior month as the Date.

5) Click Next.

6) Enter 5000 as the Credit Limit.

7) Click Info to enter any additional account information and
Click OK when finished.

8) Click the "Start with Summary" box.

9) Click Done to complete the setup.

10) Quicken opens the "1st Credit Card" account register.

11) Enter the 10th of the prior month as the Date and1101
as the Reference number.

12) Enter Quality Restaurant as the Payee and12.34as the
amount in the Charge field.

13) At the Category field,Slowly type Dining. Quicken finds
and selects "Dining" from the drop-down Category list.

14) Press Tabto enter the category.

15) Enter Birthday in the Memo field.

16) Record the transaction.
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TRANSFER FUNDS FROM CHECKING TO CREDIT CARD ACCOUNT

1) Click the "1st Bank-Chkg" button to reopen the checking
account register.

2) We could again use the Transfer button to pay our credit
card. After recording the transfer we would need to edit the
transaction to indicate a check number rather than TXFR in
the Number field. Instead, we will use the normal
transaction entry approach.

Enter the 1st of the current month as the Date.

3) Press +to increment the check number andPress Tab.

4) Enter 1st Credit Card Bank as the Payee and65 as the
Payment.

5) At the Category field,Slowly begin typing 1st Credit
Card. Quicken finds and selects [1st Credit Card] from the
drop-down Category list. Again, note the square brackets
that distinguish it as an account.

6) Press Tabto enter the category.

7) Record the transaction.

8) Highlight this last entry andPress Ctrl+X, the Quick Key
to go to the "1st Credit Card" account register.

9) Note the other side of this transfer.

10) Close the credit card account register.

11) Note the current balances of the accounts shown on the
Account List. Note the Balance Total of $1,127.57, which
is the total of the bank accounts less the credit card
account.

12) Backup your data and exit.
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CONCLUSION

In this lesson we have entered and split transactions, edited
categories and added subcategories. We have also added a savings
and credit card account, entered typical transactions in those
accounts, and transferred funds from our checking account.

In our next lesson we will explore memorized and scheduled
transactions and will take a look at our financial calendar.
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OBJECTIVES OF LESSON 3:

· Add, edit and delete memorized transactions

· Recall memorized transactions

· Schedule transactions using the Financial Calendar

· Select which transactions appear on our historical financial calendar

· Create notes as reminders

· Test an automatic recording of a scheduled transaction
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MEMORIZE TRANSACTIONS

1) Reopen Quicken for Windows.

2) If the Quicken Reminders window appears, Click Close.

3) Click the Lists menu.

4) Note that Ctrl+T is the Quick Key to open the Memorized
Transaction List.

5) Click "Memorized Transaction".

6) Note that Quicken has memorized every transaction we
have entered.

Depending on the volume of your transactions you may not
want to memorize every new transaction. We can limit the
number of memorized transactions that stay on the
Memorized Transaction List.

7) Note the far right column under the heading "Cal". A small
calendar icon in this column indicates it has also been
memorized to the Financial Calendar's Transaction List.

Depending on the volume of your transactions you may not
want to memorize every transaction to the Financial
Calendar's Transaction List. (We will be exploring our
Financial Calendar and scheduled transactions later in this
lesson.)

8) Click Options from the Edit menu.

9) Click General.
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MEMORIZE TRANSACTIONS, Continued

10) Note the option "Remove Memorized Transactions Not
Used in Last ____ Months". When this option is checked,
Quicken removes unlocked memorized transactions from
the Memorized Transactions List if they have not been used
during the number of months you specify. (We will be
exploring locked memorized transactions later in this
lesson.)

11) Add a checkmark to enable "Remove Memorized
Transactions Not Used in Last".

12) Enter 6 as the Number of months. (You will likely want to
change this setting at some point in your actual data file.)

13) Click OK.

14) Click OK after reading the information window.

15) Click Register andClick the QuickFill tab.

16) Note the option "Automatic Memorization of New
Transactions". We could further limit the number of
memorized transactions by disabling this option. When this
option is disabled, only transactions that are manually
memorized are added to the list. (We will be manually
entering memorized transactions later in this lesson.)

Since we have already limited the memorized transactions
by the number of months of inactivity, we will leave this
option enabled. You may want to change this setting at
some point in your actual data file.

17) Note the option "Auto Memorize to the Calendar List".
When this option is disabled, only transactions that are
manually memorized are added to the calendar list.

18) Remove the checkmark to disable "Auto Memorize to
the Calendar List".
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MEMORIZE TRANSACTIONS, Continued

19) At times the drop-down lists get in our way. Let us turn off
the automatic drop-down feature since we can click a drop-
down button (or click our right mouse button) when the
need arises.

Remove the checkmark to disable "Drop Down Lists
Automatically".

20) The other options should remain checked.

21) Click OK andClose the Options window.

22) Let us delete a memorized transaction that may not be
repeated in the future. (This does notdelete the actual
transaction in the account register.)

Highlight the "Vacation Airlines" entry and Click
Delete.

23) Click OK at the information and confirmation window.

24) You may not want to memorize the amountsfor some
transactions, especially split transactions. We can lock in
zero amounts so that incorrect amounts are not entered by
mistake.

Highlight the "Super Market" entry andClick Edit.

25) Click Splits.

26) Change the Amounts for "Groceries" and for "Misc" to
zero.

27) Click Adj. Tot. to adjust the total to zero.

28) If Amounts on all lines and the "Transaction Total" at the
lower right corner of the window are zero,Click OK.
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MEMORIZE TRANSACTIONS, Continued

29) Back at the Edit Memorized Transaction window, the
Amount field should now indicate 0.00.

30) Click OK to complete the edit.

31) If we now lock this transaction, the Payment field will not
change the next time we enter a "Super Market" transaction.

Click the Lck column to the right of "Super Market"
and note that a padlock icon appears.

32) Now let us add an ATM transaction to our Memorized
Transaction List.Click New.

33) Press Tabto accept Payment as the Type.

34) Enter ATM as the Payee.

35) Tab past the Memo field.

36) Enter ATM Withdrawal as the Category.

37) Quicken will open the Set Up Category window.

Set up this new category as an expense.

38) Enter the amount of your typical ATM withdrawal .

39) Click OK to create the memorized transaction.

40) Note the padlock icon to the right of our new ATM
transaction. Manually memorized transactions are
automatically locked.

41) Close the Memorized Transaction List.
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RECALL MEMORIZED TRANSACTIONS

Now let us enter some transactions and see how our Memorized
Transaction List helps us record transactions.

1) Open the "1st Bank-Chkg" account register.

2) Click the calendar icon to the right of the Date field.

If a calendar icon does not appear to the right of the Date
field, click on the Date field.

3) Click on any date in the current month andPress Tab.

This is useful when you know what day you visited the
ATM, for example, but do not recall the date.

4) Click the drop-down button to the right of the Number
field.

5) Click "ATM" from the drop-down Number list andPress
Tab.

6) Click the drop-down button to the right of the Category
field.

7) Click "ATM" from the drop-down Payee list.

8) Note that the Payment and Category fields are automatically
filled in. You will need to change the Payment whenever
your ATM withdrawal is different from the amount that you
locked in.

9) Record the transaction.
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RECALL MEMORIZED TRANSACTIONS, Continued

10) Enter today's date and increment the check number.

11) Begin typing Super Market. Quicken finds and selects
"Super Market" from the Memorized Transaction List.

12) Press Tabto enter the payee.

13) Note that the Payment field was not automatically filled in
since we locked in zero amounts in our Memorized
Transaction List.

14) Enter 76.54as the Payment.

15) Click Splits.

16) Enter 56.54as the Amount for Groceries and20.00as the
Amount for Misc cash back.

17) Note that the Transaction Total is 76.54 and the Remainder
is zero.

18) Click OK.

19) Record the transaction.
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A CALENDAR VIEW OF OUR TRANSACTION REGISTERS

1) Click Calendar from the iconbar.

2) Read the QcardandClick its Help button.

3) Read topics of interest in the Help window.

4) Close the Help window and Close the Qcard when
finished.

5) Note the "Register", "Schedule" and "Show Both" buttons
at the bottom of the window.

6) Click the Register button.

7) Every transaction we have entered is also included on the
Register view of our Financial Calendar (except for
transactions in accounts we choose to omit). However, only
three to four transactions per day are visible, and only one
or two are visible when showing the Account Graph. You
must click on a date in order to view all the day's
transactions. Thus, the Register view will be less useful if
you have many daily transactions.

8) Click the Previous button, which is located below the
Financial Calendar title bar, and note that "Vacation
Airlines" appears on the 5th.

9) Double-click on the 5th of the month.

10) Note that the "Vacation Airlines" transaction is listed in a
window and is highlighted.

11) Click Edit.

12) Quicken opens the Edit Register Transaction window.

13) Change the memo to Atlanta trip andClick OK.
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A CALENDAR VIEW OF OUR TRANSACTION REGISTERS, Continued

14) Click again on that date, and this timeClick Register.

15) Note the Memo field now shows Atlanta instead of Boston.

16) Close the register.

17) Use the same procedure and this timeClick Delete to
delete the "Vacation Airlines" transaction.

18) Note the strong warning!It is not advisable to delete
transactions in this manner. You may think you are only
deleting a transaction from the calendar, while in fact, you
are deleting the transaction entirely!

19) Click Cancel.

20) Note that "Quality Restaurant" appears on the 10th. Recall
that this was a credit card transaction.

21) Click Options, which is located below the Financial
Calendar title bar.

22) Note that all accounts are selected. You may not want to
see credit card transactions on your financial calendar.

23) Click on "1st Credit Card" to exclude "1st Credit Card"
transactions from the calendar.

24) Click OK to return to the calendar.

25) Note that "Quality Restaurant" no longer appears on the
calendar.

26) Click the Next button until the current month calendar is
displayed.
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SCHEDULED TRANSACTIONS

1) Click the Scheduled button.

2) This is a view of future scheduled transactions. It is blank
since we have not yet scheduled any transactions.

3) Note the Financial Calendar Transaction List to the right of
the calendar. These are the transactions that have been
"Auto Memorized to the Calendar List" (one of our
QuickFill options). We use this transaction list to help us
schedule future transactions.

4) You may not want to see all of your transactions on your
Financial Calendar Transaction List. It can become a very
long list. One way to limit the list is to disable the "Auto
Memorize to the Calendar List" option (which we did
earlier). We can also remove the Calendar icon from
transactions that have already been memorized to the
calendar list.

Click the Manage List button, which is located at the
lower right corner the window.

5) Quicken opens the Memorized Transaction List.

Click the calendar icons to the right of those transactions
you will not likely be scheduling. (DO NOT remove the
calendar icon for the "State of California" entry, since we
will be scheduling that transaction.)

6) Close the Memorized Transaction List.

7) Note that those transactions no longer appear on the
Financial Calendar Transaction List.
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SCHEDULED TRANSACTIONS, Continued

8) Let us assume our State of California pension check is
directly deposited into our bank every month.

Click on the "State of California" transaction so that it
is highlighted.

9) Drag the "State of California" transaction to today's
date. (To drag an item, press and hold down the left mouse
button while you move the mouse.)

10) Quickens opens the New Transaction window.

11) Note the entries that Quicken has already completed,
especially the Frequency and the Number of Payments
fields.

12) Click the drop-down button to the right of the Frequency
field.

13) We will be receiving our pension every month.

Click "Monthly".

14) Note the Number of Payments changed to 999. You would
change the number of payments for items like mortgage
payments or leases that have a specified number of
payments.

15) Click the drop-down button to the right of the "Register
entry" field.

16) Click "Prompt before enter".

17) Enter 0 as the Days in advance.

18) Click the Help button and read topics of interest.

19) Close the Help windowwhen finished.
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SCHEDULED TRANSACTIONS, Continued

20) Click OK to schedule the transaction.

21) If Quicken opens an information window, read the text and
click OK.

22) Note that "State of California" now appears on the
Scheduled view of our financial calendar.

23) Click Next to see the Scheduled view of the calendar in
subsequent months. These transactions will not appear in
the Register view until they are automatically recorded.

24) Click Prev until the current month calendar is displayed.

25) Click the Register button.

26) Click the View button , which is located below the
Financial Calendar title bar.

27) Click "Show Account Graph".

28) Note the resulting bar graph. It shows the total of our
checking and savings account balances (we removed our
credit card account from the bar graph). It also projects
balances a number of days in the future, based upon the
transactions we have scheduled. (There is not much to see
at this point since we have not entered or scheduled many
transactions.) Keep in mind that this view leaves less room
to view transaction entries on the calendar.
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REMINDER NOTES

Now let us take a look at Reminder Notes, which are notes we
write to ourselves that can be displayed a number of days in
advance.

1) Click on a date within 7 days of today's date.The date
will become shaded.

2) Click the Note button, which is located below the
Financial Calendar title bar.

3) Note that the date you selected appears above the text area
of the Note window.

4) Type Mother's birthday in the text area.

5) Click Save.

6) Note the square box in the upper right corner of the date
you selected.

7) Click the square box.

Your Note window opens for viewing or editing.

8) Click Cancel.

9) Close the Financial Calendar.

10) To see how our Scheduled Transactions work, we need to
exit and reopen Quicken for Windows.

Click "Exit" from the File menu.
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AUTOMATICALLY RECORD A SCHEDULED TRANSACTION
AND VIEW OUR REMINDERS

1) Reopen Quicken for Windows.

2) Quicken automatically opens the Scheduled Transactions
Due window since we scheduled a transaction for today and
selected "Prompt before enter".

Scheduled transactions for which we select "Automatically
enter" would not appear in this window. They would
automatically be entered in our transaction register.

3) We might edit the transaction if, for example, the amount
actually received is different from the amount scheduled.

Click Edit.

4) Change the Amount to 825.00.

5) Click OK.

6) Click Record to record the transaction.

7) Next Quicken automatically opens the Quicken Reminders
window. Our notes for the next 7 days appear in the
window.

8) We can also show notes for a different time period.

Click the drop-down button to the right of the "Show
Notes for" field.

9) Click a different time period and note the changes.

10) Close the Quicken Reminderswindow.

11) Open the "1st Bank-Chkg" account register.

12) Note that the "State of California" deposit has been
recorded. (You may need to scroll up the register.)

13) Backup your data and exit.
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CONCLUSION

In this lesson we have memorized transactions and have scheduled
and recorded transactions using our financial calendar. We have
also written notes which will appear as reminders in the future.

Our next lesson will be a workshop, where you can use your own
material to work on.

If you have not already done so, you will create a real data file for
you personal checking, savings and credit card accounts. We will
create and memorize informative reports.

Remember to have available your personal check book registers
and credit card statements.
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OBJECTIVES OF LESSON 4:

· Create a real data file with your personal checking,
savings and credit card accounts

· Enter real transactions

· View and customize pre-designed reports

· Create and memorize your own special reports

· Explore other Quicken reports and graphs
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CREATE A REAL DATA FILE

1) Refer to the section "Set Up a New File" in Lesson 1 on
page 5, and begin setting up your personal data file.

Select a name for your personal data file. For example, I
use DLBDATA for current year data. At year-end, I will
tell Quicken to name the prior year data file DLB1996.

Select the Predefined Categories that will meet your needs.

2) Refer to the section "Set Up Your First New Account" in
Lesson 1, and set up your various bank accounts and credit
card accounts.

I recommend you select a beginning balance and a start
date that coincides with your last bank reconciliation. If you
wish to start a number of months back or at the beginning
of the year, it will take more time to reconcile you bank
account, but it can be done.

ENTER REAL TRANSACTIONS

1) Begin entering real transactions in your various accounts,
add or modify categories, and memorize special recurring
transactions. Refer to previous lessons when you need help.

Note: As we explore the various Quicken reports, it will be more
illustrative and meaningful if you are able to use a real data file
having a number of transactions. However, if you are anxious to
move along with the tutorial using this tutorial data file (TUTOR5),
I encourage you to enter a number of fictitious entries in each of
the account registers.
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VIEW AND CUSTOMIZE A CASH FLOW REPORT

Use your personal data file or the tutorial data file (TUTOR5).

1) Click the Reports menu.

2) Click "Home".

3) Click "Cash Flow".

4) Note that Quicken opens the Create Report window and
selects the Home tab which includes the Cash Flow report.

5) Click the Cancel button.

6) Now, Click Reports from the iconbar.

7) Note that this alternate method brings us to the same Create
Report window, with the same reports and their samples
displayed.

8) Note the tabs "EasyAnswers", "Home", "Investment",
"Business", "Other" and "Memorized". Quicken refers to
these as "Report Families".

9) Click each tab and Click up and down its vertical scroll
bars; note the various reports that are available and their
samples.

10) Click "Show Report Sample" to disable the sample
reports; the result is to display more of the reports.

11) If you prefer to see the sample reports, click "Show Report
Sample" so that its box is again checked.

12) Click the Home tab.
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VIEW AND CUSTOMIZE A CASH FLOW REPORT, Continued

13) Let us take look at a financial statement type of report.

Click the drop-down button below "Report Dates" and
note the choices of time periods.

14) Click "Year to date" (or "Earliest to date" if you have
entries in both the current and prior year).

15) Click the icon to the left of "Cash Flow".

16) Note the resulting Cash Flow Report, especially the
Category Description "Int Inc".

17) Click the Options button, which is located below the Cash
Flow Report title bar.

18) Quicken opens the Report Options window.

19) Click "Description" for both the Account and Category
Displays.

20) Click OK.

21) Note the expanded Category Description "Interest Income".

22) Click the Customize button.

23) Quicken opens the Customize Cash Flow Report window.

24) Note the tabs "Display", "Accounts", "Include" and
"Advanced". The "Display" tab should already be selected.

25) We will accept "Cash Flow Report" as the Report title.

26) We will accept "Category" for the Row headings and "Don't
Subtotal" for the Column headings.
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VIEW AND CUSTOMIZE A CASH FLOW REPORT, Continued

27) "Category" and "Amount" should be checked under "Show
Columns".

28) We will accept "Cash Flow Basis" as the organization.

29) Click the Accounts tab.

30) A checkmark means that transactions from the account are
included in the report.

31) Click on an account to exclude it from the report.

32) Click again to include it.

33) Click Bank to exclude the bank accounts. Click again to
include them.

34) Click "Clear All" to exclude all the accounts.

35) Click "Mark All" to include all the accounts.

36) Click the Create button, which is located at the bottom of
the window.

37) Note that "Bank,Cash,CC Accounts" or "Selected Accounts"
appears near the top of the report, depending on which
accounts you chose to include.

38) Note the headings "INFLOWS" and "OUTFLOWS".

39) Scroll through the resulting "Cash Flow Report".

This report shows year to date (or earliest to date) totals of
all your income and expense categories that originated from
your selected accounts.

40) Click the Print button , which is located below the Cash
Flow Report title bar.
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VIEW AND CUSTOMIZE A CASH FLOW REPORT, Continued

41) Note the various print options. We will not explore these
options for the purpose of this tutorial.

42) Click the Preview button.

43) Click the Zoom In button.

44) Click the scroll bars to view the report.

45) Click the Zoom Out button.

46) Click the Print button if you want to print this report;
otherwiseClick the Close button.

47) Click the Customize button.

48) Click the drop-down button to the right of the
Organization field.

49) Click "Income and Expense".

The only difference between "Income and expense" vs.
"Cash flow basis" is the headings on the reports.

50) Change the Report tile to Income Statement.

51) Click the Create button.

52) Note the change in the report title to Income Statement.
Note also the changes in the report headings, from Inflows
and Outflows to Income and Expenses.

53) Move your mouse pointer over the amount for one of
the categories.

Note the pointer changes to a magnifying glass. This
indicates a QuickZoom Report is available.

54) Double-click your mouse.
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VIEW AND CUSTOMIZE A CASH FLOW REPORT, Continued

55) Note the resulting transaction report.

56) Double-click your mouse pointer over one of the
transactions.

57) You are now brought to the transaction register where you
may view, edit or delete the transaction.

58) Close the register and Close the QuickZoom Report.

59) Close the Income Statement Report.
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VIEW AND CUSTOMIZE AN ITEMIZED CATEGORIES REPORT

1) Let us now take a look at the detailed income and expenses
that were included in our Cash Flow Report.

Again, Click Reports from the iconbar.

2) If the Home tab is not already selected, Click on it.

3) Under Report Dates,Click "Year to date" (or "Earliest to
date").

4) Click the icon to the left of "Itemized Categories".

5) Note the resulting Itemized Category Report, especially the
column headings.

6) Click the Customize button.

7) Note the default is to subtotal by Category and to sort by
None. Note that all column headings are checked to be
included in the report.

8) Let us remove the Memo column from our report.

Click "Memo", which is located below Show Columns.

9) Click the Create button to view the changes.

10) Note the absence of the Memo column. Note also that the
transactions within each category may not appear to be
sorted.

There are a number of ways to sort this report within each
category.

11) Click the Sort button, which is located below the Itemized
Transaction Report title bar.

12) Click "Date/Acct" to sort first by date, then by account
type, and then by account name.
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VIEW AND CUSTOMIZE AN ITEMIZED CATEGORIES REPORT, Continued

13) Click OK.

14) Scroll down the report and note how transactions within
each category are sorted.

15) Click the Sort button again.

16) This time Click "Payee" to sort by payee within each
category.

17) Click OK.

18) Scroll down the report and note the changes.

19) As you scroll down to the bottom of the report, notice that
this report shows "Transfers" and "Balances Forward". This
information can be useful, but you may not want it shown
on your printer report. We can exclude this information. We
can also filter our report based on the type and the amount
of the transactions.

20) Click Customize.

21) Click the Advanced tab.

22) Click the drop-down button to the right of the Transfers
field.

23) Click "Exclude All".

24) Click the drop-down button to the right of the Transaction
Types field.

25) Click "Payments".

26) Click the drop-down button to the right of the Transaction
Amounts field.

27) Click "greater than".
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VIEW AND CUSTOMIZE AN ITEMIZED CATEGORIES REPORT, Continued

28) Press Tab or Click on the Amount field and Enter
100.00.

29) Click the Create button.

30) Note that only payments greater than $100.00 are included
in this report. Also note that the Transfers and Balances
Forward no longer appear on the report.

31) Double-click your mouse pointer over one of the
transactions.

32) You are now brought to the transaction register where you
may view, edit or delete the transaction.

33) Close the register.

34) Close the Itemized Category Report.
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CREATE AND MEMORIZE SPECIAL REPORTS

You will want to create special reports and memorize them for
future use. For example, I memorize a report of medical expenses
sorted by Payee. Let us create and memorize such a report of
categories in which you have entered a few transactions. If you are
using the tutorial data rather than your own, the Automobile
categories contain at least one transaction.

1) Click Reports from the iconbar.

2) Under Home reports,Click the Itemized Categories
button. (DO NOT click its icon.) Itemized Categories
should now be highlighted.

3) Click the Customize button.

4) Select the appropriate Report Dates range.

5) Select Subtotal by "Payee".

6) Select Sort by "Date/Acct".

7) Click the Include tab.

Note that all categories are selected by default.

8) If we enter Autoat the "Category Contains" field, the report
will only include every main categoryand every
subcategorythat contains the work "Auto" (e.g. Auto
Expense and Insurance:Auto). It will also include every
subcategory of every main category that contains the word
"Auto" (e.g. Auto:Licenses and Auto:Repairs).

At the "Category Contains" field,Enter a word that is
contained in more than one income or expense category
you want to track (e.g. Auto, Medical, Tax). Since
Quicken fills the field with the first category that contains
that word, you may need to remove any extra words by
using Space or Backspace.
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CREATE AND MEMORIZE SPECIAL REPORTS, Continued

9) Click the Accounts tab.

10) Click to remove the checkmark next to accounts you
may want to eliminate from this report. For example, you
may want to exclude checks written out of your personal or
business checking account. But be aware that any account
you add later must be manually included in a memorized
report if you do not Select All accounts.

11) Click the Display tab.

12) Enter an appropriate Title for this report (e.g.
Automobile Expenses).

13) Click the Create button.

14) Note the resulting report.

15) Now let us memorize this report for future use.

Click the Memorize button.

16) Note the title of your report appears in the Title field. You
may want to memorize it using a different name. If so, you
would change the title here.

Note the three Report Dates options. We used a Named
Range for this report, i.e. "Year to date" or "Earliest to
date". You may want to use a custom date, e.g. 01/01/96
through 03/31/96. Or you may want to use a Report Default
date that can be set up in Report Options.

Note the Description field under Memorize Report List
Item. You can use this field to further describe this report.

If any of the icons seem more meaningful for this report,
you can select one by clicking on it. (I like the Duck).

17) At the Description field,Enter Sorted by Payee.
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CREATE AND MEMORIZE SPECIAL REPORTS, Continued

18) Click OK.

You should hear beeps confirming the report has been
memorized.

19) Now let us close and reopen this memorized report.

Click the Close button.

20) Click Reports from the iconbar.

21) Click the Memorized tab.

22) Note the Report Title and the additional description (Sorted
by Payee).

23) Click its icon.

24) Note the resulting report.

25) Click the Close button.

26) Now let us create and memorize a report by including
specific categories.

Click Reports on the iconbar.

27) Click the Home tab.

28) Click the Itemized Categories button.(DO NOT click its
icon.)

29) Click the Customize button.

30) Select an appropriate Report Dates range.

31) Accept Subtotal by Category.

32) Select Sort by "Acct/Chk#" (to observe any differences).
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CREATE AND MEMORIZE SPECIAL REPORTS, Continued

33) Click the Include tab.

34) Click "Clear All".

35) Click "Int Inc" and "Pension".

36) Click the Display tab.

37) Enter Interest and Pension Incomeas the Report Title.

38) Click the Create button.

39) Note the resulting report.

40) Click the Memorize button.

41) Select an appropriate icon(the pig bank?).

42) Click OK.

43) Create and memorize some other reports. You might try
medical expenses sorted by payee; food or entertainment
sorted by date; etc.
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VIEW A PAYEE REPORT

The Payee Report is easily accessible from an open account
register. It is a transaction report that has no subtotals and no sorts,
selects only the account register that is currently open, and matches
the payee of the transaction that is highlighted.

1) Open one of your account registers.

2) Highlight a transaction, preferably where the payee has
been paid more than once, out of more than one account,
and possibly has been charged to more than one category
during the period.

3) Click the Report button, which is located below the
register title bar.

4) Note the resulting report. It includes payments out of the
current account to the selected payee and includes all
categories. We can further customize this report.

5) Click the Customize button.

6) Click the Accounts tab.

7) Click "Mark All".

This will be to include payees who were also paid from
other checking or credit card accounts as well as the
account that is currently open.
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VIEW A PAYEE REPORT, Continued

8) Click the Include tab.

9) Note that all categories are selected. Suppose you want a
report of payments to a particular pharmacy, but only if it
involved the purchase of medicine; you do not want to
include food and sundry items. You would Clear All
categories and Select only the Medicine category.

Other examples would be to select payments to a particular
service station for automobile repairs but not for fuel; or
payments to a particular city for utilities or licenses but not
for parking citations.

If you have highlighted such a transaction, Clear All
categories and select the categories you want to include in
the report.

10) Click the Create button.

11) Note any changes in the Payee Report.

12) Click the Close button.

13) Press Ctrl+End, the Quick Key to go to the end of the
register.
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EXPLORE OTHER QUICKEN REPORTS AND GRAPHS

1) Click Reports from the iconbar.

2) Under Home reports,Click the Net Worth icon.

3) You can customize this report. For example, you may want
to change the title to Balance Sheet, or you may want to
exclude certain accounts.

4) Close this report.

5) Under Home reports,Click the Comparison button. (DO
NOT click its icon.)

6) Note the Comparison dates at the top of the tab. The dates
will likely compare "Year to date" with "Last Year" unless
you have change the defaults in Report Options. If you
have only transactions in the current year you might want
to change the comparison to "Quarter to date" and "Last
Quarter"; or "Month to date" and "Last Month".

7) Now Click the Comparison icon to view the report.

8) You can customize this report in the same manner as the
Cash Flow Report. In addition, you can show the
differences between periods as a percentage instead of as an
amount.

9) Close this report.

10) Click Graphs from the iconbar.

11) Accept the default dates or enter new beginning and ending
dates.

12) Note the Accounts, Categories and Classes filters at the
bottom of the window. These are similar to the Account
and Include tabs we explored for our reports. Let us leave
them alone for now.
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EXPLORE OTHER QUICKEN REPORTS AND GRAPHS, Continued

13) Select the Income and Expense graph and Click Create.

Note the resulting graph by period and by expense category.

14) Move your mouse pointer to different areas of the graph
and Double-click your mouse pointer when a magnifying
glass appears.

Note the resulting graphs.

15) Close the QuickZoom graph and Close the Income and
Expense graph.

16) Under Graphs, this timeSelect the Net Worth graph.

Note the resulting graph by period.

17) Move your mouse pointer to different areas of the graph
and Double-click your mouse pointer when a magnifying
glass appears.

Note the resulting graphs.

18) Close the QuickZoom graph and Close the Net Worth
graph.

19) Explore some of the reports under the EasyAnswers and the
Other reports tabs. You will notice that many of the reports
under these tabs seem the same or very similar to the
reports you have explored under the Home tab. Intuit, the
developers of Quicken, realize that users come from
different backgrounds and are familiar with different
terminology. I may be familiar with Cash Flow and Net
Worth reports, but "Where did I spend my money" and
"What am I worth as of today" may be more familiar and
meaningful to someone else. They are the same reports. I
encourage you to choose the reports that are most
meaningful to you, and understand they can be customized
in the same manner as the reports in this tutorial.
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EXPLORE OTHER QUICKEN REPORTS AND GRAPHS, Continued

20) The Investment Reports and Business Reports are beyond
the scope of this tutorial. I encourage you to explore them
and use them when they meet your needs.

21) Finally, whenever you modify a report, be sure to memorize
it if you think it will be useful in the future.
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CONCLUSION

In this lesson we viewed and customized various reports. We also
created and memorized our own special reports that meet our
particular needs.

I trust this tutorial has helped you learn and use Quicken and that it
has inspired you to manage your finances on a regular basis.
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